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Milli Egitim Bakanlig: tarafindan gelistirilen moduller;

Talim ve Terbiye Kurulu Bagkanligimin 02.06.2006 tarih ve 269 sayili
Karar ile onaylanan, Medeki ve Teknik Egitim Okul ve Kurumlarinda
kademeli olarak yayginlastirilan 42 alan ve 192 dala ait cerceve Ggretim
programlarinda amaclanan mesleki yeterlikleri kazandirmaya yonelik
gelistirilmis Ogretim materyalleridir (Ders Notlaridir).

Moddller, bireylere mesleki yeterlik kazandirmak ve bireysel dgrenmeye

renberlik etmek amaciyla 6grenme materyali olarak hazirlanmus,
denenmek ve gelistirilmek Uzere Medeki ve Teknik Egitim Okul ve
Kurumlarinda uygulanmaya baslanmustir.

Moduller teknolojik gelismelere paralel olarak, amaglanan yeterligi
kazandirmak kosulu ile egitim Ogretim sirasinda gelistirilebilir ve
yapilmasi 6nerilen degisiklikler Bakanliktailgili birime bildirilir.

Orgiin ve yaygin egitim kurumlari, isletmeler ve kendi kendine mesleki
yeterlik kazanmak isteyen bireyler modillere internet Uzerinden
ulasilabilirler.

Basilmis moduller, egitim kurumlarinda Ogrencilere Ucretsiz olarak
dagitilir.

Modduller highbir sekilde ticari amagla kullamlamaz ve Ucret karsiliginda
satilamaz.




ACTKLAMALAR L.t ii

GIRIS oottt sttt sttt sttt s 1
OGRENME FAALIYETI= L oot seses s esns st 3
1 FATURA/RSALIYE. ...ttt eeeee s s sen st sas st sn s sn s aenanens 3
O = L0 = PP TRTORRP 3
I = 0 = B 1= | TSP U TUURUUTUPRPRRIN 3
O e (U= W = 07 T S 4
1.1.3. Faturada Yasal ZOrunlUlUKIEr ..........cc.coeeiiiiiniiiie e 5

R 5= Y= YOO 5
1.2.1. IrSaliye TANMML......vivieciciecc ettt 5
1.2.2. IrSaliye El@MANIAI.......ceeecvereeeeeeececteeeie sttt s st s s s en st sesssenenees 6
1.2.3. Irsaliyede Yasal ZOTrUNIUIUKIAL ..........c.ocovvceeueeeieeecceceete s ses st nees 6

1.3, IrSAlYElT FOIUMAL......cvuiviecvcecicice ettt bbb 7
1.3.1. Irsaliyeli FAUraTANML ...c.cvucviveiecvieeicvce et 7
1.3.2. Irsaliyeli Fatura El@mManl @l .........ccceeveveeeeceeieeeeseeeeeeeete s st sesesessesesssssennees 7
1.3.3. Irsaliyeli Faturada Y asal ZorunlUIUKIAr ............c.cvvveeveeeeeeeeeeeeee e eneeas 7

1.4. Vektorel Grafik Tasarim ve illustrasyon Programlari...........cccceeeveeeereeveiecuseneiecnnnnnns 8
1.4.1. TammMi V& OZEITKIEN .......oecvveeceeeeeceece et 8
O O DTSy 37= W @ =10 1 P 9

1.5. Vektord Grafik Tasarim ve illustrasyon Programinda Fatura/irsaliye Reprodiiksiyonu
(@413 o PRSP 11
1.5.1. Temel Geometrik Cizim Araglaryla Fatura/irsaliye Olusturma......................... 11

UY GULAMA FAALIYETT oottt senae s 28
OLCME VE DEGERLENDIRME........coouiieeieeseeeseieeesiesseesessssessssesssssssestesssessssesesssssnesnenns 31
OGRENME FAALIYETI= 2 oottt ten st 34
2. CIKIS VE KONTOL ...ctiiiiieiesieie ettt saesa st sesaenessenessenessenes 34
2.1. YaziC1 Cesitleri Ve OZElIKIE i ........oucveeieiereiece e 34
2.1.1. Mirekkep Puskirtmeli - INk-Jet YaziCllar...........ccovveeveeieiieie e 34
2.1.2. Termal Transfer-Dye Sublimation-Solid Ink Yazicilar ..........cccccecvvveeeieieennene, 35
ARG T IN-v.= g =74 (s K- S 35
2.1.4. Lazer PozlandiriCilar - ImMage SELEr .......ccooiiiiriieieceeeees s 36

A O3 T NV 11 - PSP 36
UY GULAMA FAALIYETT oot 38
OLCME VE DEGERLENDIRME ......oovcveeeeetseeeeeesetesesestssssesassessensssss s sssessnssnens 40
MODUL DEGERLENDIRME ......ouiiueiiveieteeeeee st tesae s sesse s s s sanae e 42
CEVAP ANAHTARLARI ..ottt sttt en 43
KAYNAKGCA oottt sttt e ae s e e se st e sesaese st ese et esestese et e s eseseeseneesessnsenens 44



ACIKLAMALAR

KOD 213GIM 184

ALAN Matbaa

DAL/MESLEK Baski Oncesi

MODULUN ADI Fatur a/irsaliye Repr odiiksiyonu

MODULUN TANIMI

Fatura/irsaliye Reprodilksiyonu ile ilgili temel bilgi ve
becerilerin kazandirildig1 6grenme materyalidir.

SURE 40/32+40/16
ON KOSUL On kosulu yoktur.
YETERLIK Fatura/irsaliye Reprodiiksiyonu yapmak

MODULUN AMACI

Genel Amag

Gerekli ortam saglandiginda, orijinade birebir uygunlukta
Fatura/irsaliye Reprodiiksiyonu yapabileceksiniz.

Amaclar

1. Vektorel ¢izim programinda orijinale birebir uygun
faturalirsaliye reprodiksiyonu yapabileceksiniz.

2. Cikis aaak kontrolleri  yapabilecek ve
gerceklestirebileceksiniz.

tashihleri

EGITIM OGRETIM
ORTAMLARI VE

Bilgisayar, Tarayici, Yazici, Projeksiyon, Internet, Uygun
Yazilhimlar, Fatura/irsaliye Arsivi

DONANIMLARI
Her fadiyet sonrasinda o faaliyetle ilgili degerlendirme
sorular ile kendi kendinizi degerlendireceksiniz.

OLCME VE

DEGERLENDIRME Ogretmen modiill sonunda size 6lgme araci (uygulama, soru-

cevap) uygulayarak modul uygulamalari ile kazandigimz bilgi
ve becerileri 6lcerek degerlendirecektir.




Sevgili Ogrenci,

Ticari fadiyette bulunan firmalar gerceklestirmis olduklari ticari islemleri
belgelendirmek zorundadir. Bu belgelerden birisi de faturadir. Eger yapilan ticaret
sonucunda bir mal, bir yerden baska bir yere tasinacaksa irsdliye dizenlenmesi
gerekmektedir.

Ticari isletmeler Maliye Bakanligr’ min izni ile fatura ve irsaliyeyi aym belge Uizerinde
belgelendirebilir. Bu tur belgeler Maliye Bakanligi'mn izni ile anlasmali matbaalar
tarafindan basilmaktadir.

Bu modilde bilgisayarda irsdiyeli fatura orijinali hazirlama ve kontrollerini yapma
islemlerini gerceklestirebilecek beceriye ulasmamz igin gerekli bilgiler verilecektir. Modul
sonunda orijinale birebir uygunlukta irsaliyeli fatura reprodiksiyonu yapma yeterliligini
kazanmaniz amaglanmaktadir.

Bu modilde hedeflenen yeterlikleri edinmeniz durumunda, matbaa teknolojis
alaninda daha nitelikli elemanlar olarak yetiseceksiniz.






OGRENME FAALIYETIi-1

C AMAC )

Bu faaliyet ile gerekli ortam saglandiginda; vektorel cizim programinda orijinale
birebir uygun fatura/irsaliye reprodiksi yonu yapabileceksiniz.

(' ARASTIRMA )

Cssitli - kuruluslarin  faturalirsaliyelerini  inceleyerek nerelerde  kullanildiklarim
arastirimz.

Faturalarda kanunen olmasi gerekenleri inceleyerek arastiriniz.

Irsaliyelerde kanunen olmas: gerekenleri inceleyerek arastiriniz.

Irsaliyeli faturada kanunen olmas: gerekenleri inceleyerek arastiriniz.

Cizgi cesitlerini ve puntolarini inceleyerek arastiriniz.

Vektorel Grafik Tasarim ve illiistrasyon programlarinin hangileri oldugunu ve
matbaacilikta hangi alanlarda kullamldiklarint arastiriniz.

1. FATURA/IRSALIYE

TTK (Turk Ticaret Kanunu) 23. maddesi uyarinca her tacir kendi ticari isletmes
geregi bir mal satrmusg, imal etmis veya bir is gbrmus yahut bir menfaat temin etmis ise diger
tarafin talebi Uzerine “fatura” vermek ve bedel ddenmisse bunu faturada gostermek
zorundadir. Fatura, VUK (Vergi Usul Kanununun da) da bazi sekil ve sartlara baglannsg
olarak diizenlenmesi gereken belgeler arasinda yer alir.

YVVVYY

Mal alis ve satiglarinda, mal1 sevk ederken stok cikislar veya yolda sevk esnasinda
meydana gelecek hasarlart tam tespit icin ve mali konum agisindan yolda ne tir mal
tasindigin ve ne kadar mal gikis1 yaptigimizi belgelemek izere evrak dizenlemek gerekir..
Satmig oldugumuz stoklart bir vasita ile aiciya gonderiyorsak mutlaka sevk irsaliyes
duzenlemek zorundayiz.

1.1. Fatura

1.1.1. Fatura Tanim

Fatura: Satilan emtia (mallar) veya yapilan is karsiliginda misterinin borglandigi
meblag1 gostermek Uzere emtiay1 satan veya isi yapan tlccar tarafindan misteriye verilen
ticari vesikadir.



Faturalar mal veya hizmet satan tacirler tarafindan duzenlenerek mal veya hizmeti
satin alan kisilere verilmektedir. Ticari hayatta gerceklestirilen her turlU ticari hareket
belgelendirilmek zorundadir. Mal1 veya hizmeti satan ile alan kisiler, muhasebe biliminde

yaptiklart isleri,
yukUmltdurler.

belgel eri

Bu yukdmlUlUklerini yerine getirebilmeleri icin fatura kullanilmaktadir.
hazirlik esnasindaiki nusha olarak diizenlenir. Bunlardan bir niishasi mali veya hizmeti satin
alan kisiye tedim edilir. Bir diger nisha da mali ve hizmeti satan firmamin muhasebe
kayitlarinda Vergi Usul Kanunu'na goére 5 yil,

saklanmak zorundadhr.

1.1.2. Fatura Elemanlari

ile birlikte istenildigi

_ Maliye Bakanh
Faturay: diizenleyenin il mwa N s ol ™Mb
adu, ticaret {invant, @
is adresi, bagh bulundugu 4—51) 5 e TAN D Faturanin basildigs
Vergi Dairesi ve T-t(mz}mnsnrx s Aty » Ve dizenlendig
Vergi Numaras: £ e oot FATURA 11 Kodu
e » Eatura [baresi
Miigteri ady, ticaret tinvam, ¢ —
is adresi, bagh bulundugu ::"“:s;:lr oy Faturanin diizenlenme
Vergi_Dairesi ve R e . i tarihi, seri ve sira
Vergi Numarasi numarast
4 cinsi TARY | Bl AT oA
Malin ve igin nev'i (cinsi) —
miktary, birim fiyat:
ve tutan
Yaa ile yaulacak +————f— orL e
yalmiz ibaresi KoV » KDV orani ve tutars
VALNIZ: YTUdr. | GENEL TOPLAM » Genel tutar

Faturay: basan matbaa
firmasimin ad, adresi,
Vergi Dairesi,Vergi Nosu ‘ vz e
Anlagma tarihi ve numaras: e
Basim yili

FORM wat Sam

 Garas Ti. 1. 4 Bagier Cag. o @ GUNESLLST.
R R Y S o S

Sekil 1.1: Fatura elemanlari

zaman Yyetkililere ibraz etmekle

Fatura

Tark Ticaret Kanunu'na gore 10 il



1.1.3. Faturada Yasal Zorunluluklar

Vergi Usul Kanunun 230. maddesine gore Maliye Bakanlig1 tarafindan tespit edilen
asagidaki bilgiler faturada bulunmak zorundadr:

1

No o hkw

Faturanmin diizenlenme tarihi seri ve siranumaras

Faturay: dizenleyenin adi, varsa ticaret unvani, is adres, bagli oldugu vergi
daires ve hesap numarasi

M Usterinin ad, ticaret unvani, adresi, varsa vergi dairesi ve hesap numarasi
Malin veyaisin nev'i (cing), miktari, fiyati ve tutar

Satilan mallarin tedim tarihi ve irsaliye numarasi

Maliye Bakanligimin Mhrii ve il Kodu

Faturaibares

Faturay1 basan matbaanin ach, adres, telefonu, bagli bulundugu vergi dairesi,
vergi numarasi ve anlasma tarihi

1.2. irsaliye

1.2.1. irsaliye Tamm

Irsaliye: Satilan veya satin ainan malin, tasinmasi sirasinda diizenlenen belgedir.
Malin nereye ve kime gonderildigini belirtir.

Malin tasinmasi (sevki) sirasinda mal ile birlikte bulunmasi gereken bir belgedir. Sevk
irsaliyesi fiyat ve bedel hari¢c olmak Uzere faturada yazili olan bilgileri tagir. Faturamn sekil
ve nizamina uygun esaslara gore diizenlenir. 3 (Ug) nusha olarak dizenlenir. Malin nereye ve
kime gonderildigi ayrica belirtilir. Muhasebe kayitlarinda Vergi Usul Kanunu’ na gore 5 yil,
Turk Ticaret Kanunu’ na gore 10 y1l saklanmak zorundadir.



1.2.2. irsaliye Elemanlar:

 Maliye Bakanlig

»
Irsaliyeyi diizenleyenin ',',:;':,‘:‘.’,Em it bl Mahri
ady, ticaret Gnvam @ :
. S 2 svmm cnsk.un ae.gyd o)
iy adresi, bagh bulundugu < E ,,"ﬁ?’ / Irsaliyenin basildigs
Vergi Dairesi ve e mmum b Ko 34 p ve dilzenlendigi
Vergi Numaras: "‘“W"""f““"‘ SEVK IRSALIYES| 11 Kodu

Irsaliye Ibaresi

Moster Ay, Adras, i
Miisteri adi, ticaret imvan, #—————— -Wﬁs‘ﬁﬁmr ;
: e E: DUZENLENE TARIHI - R
ig adresi, bagll‘buh_mdpgu J ewry | ————F lrsalxyegm duz'an]enme,
Vergi Dairesi ve B o bie e e - sevk tarihi, seri ve sira
Vergi Numarast i i numarast

Malm ve igin nev'i (cinsi) ¢
miktari, birim fiyat:
ve tutan

Irsaliyeyi basan matbaa
firmasimin ad, adresi,

Vergi Dairesi, Vergi Nosu 5 o s O i o, et o SN
Anlagma tarihi ve numarasi

Basim yili

Sekil 1.2: irsaliye elemanlara

1.2.3. irsaliyede Yasal Zorunluluklar

Maliye Bakanhg tarafindan tespit edilen asagidaki bilgiler faturada bulunmak
zorundadhr:

Irsaliyenin diizenlenme tarihi seri ve siranumarasi

Irsaliyeyi diizenleyenin ach, varsa ticaret unvani, is adresi, bagl oldugu vergi
daires ve hesap numarasi

M Usterinin adi, ticaret unvani, adresi, varsa vergi dairesi ve hesap numarasi
Malin veyaisin nev'i (cing), miktari, fiyati ve tutar

Satilan mallarin tarihi vefiili sevk tarihi

Maliye Bakanligimin Mihri ve Il Koduirsaliye ibaresi

Irsaliyeyi basan matbaanmn adch, adresi, telefonu, bagl bulundugu vergi dairesi,
vergi numarasi ve anlasmatarihi

VVVVY VY



1.3. Irsaliyeli Fatura

1.3.1. irsaliyeli Fatura Tanim

Vergi Usul Kanunu' nun 257. maddesinin Maliye Bakanligi’ na vermis oldugu yetkiye
dayanarak, Fatura ve Sevk Irsaliyes’nin ayr1 ayn belgeler olarak degil de, isteyen
miikellefler acisindan irsaliyeli Fatura ach altinda tek belge halinde diizenlenmis haline
irsaliyeli fatura denir.

1.3.2. irsaliyeli Fatura Elemanlar1

_ Maliye Bakanhg

irsaliyeli faturay: g or OKTAYOURAN e Miihrit
diizenleyenin i] DONER SERMAYE ISLETMES! ﬁ@ T
ady, ticaret iinvam, ¢———— Ei) 5.";&;&“*"““’”"' I Irsaliyeli Faturanin
i i, bag & Tel: (0212) 426 09 74 Fax: (0212)426 0973 basildig v
i adresi, bagh. bulpndggu 1 Vlfn'w Dmn'«mp No: Av‘uTIlE4M4§24830U I Kodu: 34 i DRiran ?, L
Vergi Dairesi ve 2 E-mail: matbaa,_ meslek@hotmail com i i diizenlendigi [I Kodu
i RSALIVELI L
Vergi Numarasi — FATURA » Irsaliye Fatura
el Ibaresi
. . R SERIASIRANO: :
Miisteri ady, ticaret tinvani,
ig adresi, bagli bulundugu DUZENLEME SAATI: g i
§ g bulundug P . ———————p lrsaliyeli Faturanin
Vergi Dairesi ve FliLl SEVK TARIHI - diizenlenme.
Vergi Numaras: e e ETRET
sevk tarihi, seri ve sira
numarasi

Mali ve igin nev’i (cinsi)
miktar, birim fiyati
ve tutar

ToPLAM
KDV %
YALNZ: YTLor. | GENEL TOPLAW|
irsaliyeyi basan matbaa

firmasmin ads, adresi, EEC . Chabatz Testm M Irsaliyeli faturanin

Vergi Dairesi,Vergi Nosu < kagmnci 6rnegi
Anlasma tarihi ve numarasi SASH YR FomM Mt S eV DA G T, LI 1. B M ol Cad. e 48 ONERLLT. ILORNEK  ——— o]dugunu gdsteren

Basim yili ornek (niishay

numarasi

Sekil 1.3: irsaliyeli fatura elemanlar:
1.3.3. irsaliyeli Faturada Yasal Zorunluluklar

Maliye Bakanligi tarafindan tespit edilen asagidaki bilgiler irsaliyeli faturada
bulunmak zorundadir:

1 Irsaliyeli faturanin diizenlenme tarihi, sevk tarihi, seri ve siranumarasi

2. Irsaliyeli faturay: diizenleyenin ach, varsa ticaret unvan, is adresi, bagl: oldugu
vergi dairesi ve hesap numarasi

3. M Usterinin adh, ticaret unvam, adresi, varsa vergi dairesi ve hesap numarasi;



Malin veyaisin nev'i (cing), miktari, fiyat1 ve tutar
Satilan mallarin satis tarihi ve fiili sevk tarihi
Maliye Bakanligimin Mihrii ve il Kodu

Irsaliyeli Faturaibares

No oA

Irsaliyeli Faturay: basan matbaamn ach, adresi, telefonu, bagli bulundugu vergi dairesi,
vergi numarasi ve anlasmatarihi

1.4. Vektorel Grafik Tasarim veillustrasyon Programlar:
1.4.1. Tamm ve Ozellikleri

Vektoérel programlar, sayfayr x-y koordinatlar: ile tanimlayip islemleri matematik
formuller ile belirten programlardir. Vektorel grafik tasarim-illustrasyon programlari, grafik
caismalar ve tasanimlar icin Uretilmislerdir. Kelime islem destekleri vardir fakat sayfa
mizanpaj programlarindaki kadar gelismis degildir.

Vektorel ¢izim programlarinda dijital goruntt cizgisel agilamr yani cizgi hatlarinda
(6zellikle yuvarlak hatlarda) herhangi bir kirilma gozlenmez. Cizgiler sirekli ve keskindir.
Bununla birlikte resim isleme programlarindaki gibi ressm 6zellikleriyle oynama, diizeltme
ve gesitli efektler verme yeterliligi oldukca azdir.

Grafik tasarim ve illustrasyon programlart brosir, ilan, afis gibi kendini tekrar
etmeyen sayfalar iceren serbest calismalarda 6zellikle tercih edilir.

Masaiisti yayincilikta baglica ¢ vektorel grafik tasarim ve illustrasyon programi
kullanmlir. Bunlar; Mac OS ve Windows ortaminda siklikla tercih edilen Freehand ve
Ilustrator ile daha gok Windows ortaminda kullanlan Corel Draw programlaridhr.

Bu modllde, Corel Drg programindan yararlanilarak fatura ve irsaiye
reprodiiksiyonu uygulamalari yapilacaktir.



1.4.2. Caliyma Ortam

A CorelDRAW 11 - [Graphic1] (WG
H* File Edt View Layot Arwange Effects Btmaps Text Tooks Window  Help EEE:
Dpeolsode-»- @0 §w.

[T T = [ e ‘ﬂ\@'ﬁ?’fﬂ; efaBm o [ B

T e e B B P B L
% Calisma Penceresi
=

e \ v

Al +— Cetveller Mendiler Men( Cubuklari

Q, (2]

5

Alg k ,

a, Renk Paleti

2, _— Calisma Sayfasi (Color Palette)

e » Arac Kutusu A-4 Savfasi

? (Toolbox) ( ylasy) -

200
i

50
i

Calisma Sayfalari
(Doékiman lgi Sayfalar)

Cahgmaalani o
Kaydirma Cubuklari

300
i

Durum Cubugu

§ v
= v
I+ Ta4 v W\ Pagel (Fage2 f Paged 7 Paged [ m B
& >
(34973, 93789)  Click an obiect tice for rotating/skewing, dblclicking tool selects all cbiects; Shifteclick muliselects: Altscick digs: Ctlelick selects inagroup ) ><

Sekil 1.4: Corel draw ¢alisma ortam

Program masalistiindeki kisayol cift tiklanarak ya da Baslat>Programlar> Coréel
Graphics Suite>CorelDraw 11 seceneginden agilabilir. CorelDraw ¢alisma ortamu Araglar
(Tools), Menti cubuklari (Toolbars), Paletler ve mentlerden olusur.

Ortada gordiuguniz biyuk beyaz alan galisma penceresi, onun ortasinda yer aan ve
cevresinde golgeli bir sinir gizgisi bulunan bdluime calisma sayfas denir. Dosya yaziciya
gonderildiginde yazilacak olan kisim burasidir. Yazdirmak istemedigimiz (ama kaydetmek
istedigimiz) grafik resimlerini, calisma sayfasinin disinda kalan ¢izim penceresi alaminda
saklayabilirsiniz.

Sol tarafta bulunan araglar toolbox yani arag kutusuna dahildir. Sag tarafta renk
paleti gorllir. Program acildiginda toolbox ara¢ kutusu yoksa, Window >Toolbars
>Toolbox komutuyla gorinmesi saglanabilir.

Calisma sayfamizin en Ust kismunda menuler bulunmaktadir. Calisma penceresinin
hemen Ustlinde ve sol yaninda cetveller bulunmaktadir.

Yine ¢alisma penceresinin en alt kisminda Page 1, Page 2, Page 3, ...... kisminda
dokiiman igerisinde bulunan ¢alisma sayfalar: siralanmustir.



b3
7" Renume Page...
| trseet o after
o] Irseet Pnge Bfees
| poiete Page
18+ 14 » MY Page R i TIRE

(91515 150040 | Chck anobiwct iwice for mtating/'theverg: dbkchcking tool selects ol o
Sekil 1.5: Sayfa ayarlari

Pick Tool aract Page 1' Uizerinde iken maus un sag tusuna bastigimnz zaman o sayfa
ile ilgili yapabileceklerimizin menisi ortaya c¢ikar. Burada; Rename Page: Sayfaya isim
vermek icgin kullanilir, Insert Page After: Bulundugumuz sayfadan sonra bos bir sayfa
acmaya yarar, Insert Page Before: Bulundugumuz sayfadan 6nce bos bir sayfa agmaya
yarar, Delete Page: O sayfasi silmek icgin kullanilir, Switch Page Orientation: Sayfa
yonini degistirmeye yarar.

Calisma penceresi’nin en saginda renk paleti bulunmaktadir. Eger renk paleti yoksa
Window > Color Palettes >Default CMYK Palette komutuyla gorinmesi saglanabilir.
Buradan istedigimiz standartlardaki bir renk paletini acabiliriz.

Yine Calisma Penceresi’nin sag ve alt sag bolgesinde Calisma Alam Kaydirma
Cubuklar1 bulunmaktadhr.
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TOOLBOX (ARAC KUTUSU)

Pick Tool
(Secim Aracr)

Hand (B)
Zoom (Blyuteg) “
3-Point Rectangle

(3 noktalidiktdrtgen)
Rectangle (Dikdortgen) “

LE
Graph Paper (zgara Araci)
Polygon Tool (Cokgen) “
lomo

Siral (Helezon)

Transparency (Saydamlik)
Drop Shadow (Golge)
Extrud e (Derinlik) T

Bend (Kanstlrmak)<H FE® SO S

Contour (Dis Hatlar) —
Digtortion (Egmek)
Envelope (Zarf)

Hgghfl%———___k_l
‘ L (Gizgi Puntolar) —

Outline Color Dialo
(Cizgi Renk Ozellideri

Outline (Gizgi OzelliKeri)

(Color Docker
Windows)

Fill ool (Dolgu Arac ) —H@_ B |
Mesh Fill Tool (Ag Dolgu Arac1)

(x]

Shape Bi¢imlendirme)
Knife (Bcak)

Eraser (Silgi)
Snudge (Bulastim ak)
— Roughen Brush (Plriiz Firga si)
H@g & T HE Free Transform (Serbest Dond trme)

Feehand (Serbest Cizim)

Bezer (Dugim Nokia si)
’7 Artistic Media (Sidl Yazi)
—— Ren (Kalem)
H"«e & Q a e, H IB+ Dimension (Boyutlandima)
i Interactive Connector

(Baglanti Cizgiler)
3-Point Curve (3 Noktal Egri)

Polyline (Sanatsal Cizm)

H [ 3-Point Hlipse (3 Noktali Hips)

Hlipse (Hips)
Basic (femel Cizim Arac1)

’7 Arrow Shapes (Yon Ok Cesitleri)

Callout Shapes

(Konusma Balonlari)

Sar Shapes (Yild iz Cesitleri)
Howchart Shapes

(Ozel semboller)

Eyedropper Tool (Dam lalik)

(Renk Renceres)|

Raintbucket Tool (Boya Kovasi)

Fll Color Dialog (Dolgu Rengi Dialogu)
Fountain Fll Dialog (Gegis Rengi)
Pattern Hil Dialog (Desen Dolgu)

. Color Docker Window
o - |== (Renk Fenceres)

L L L No Fill (Dolgu iptal)

PostScript Fill Dialog (Dipnot Dolgu)
Texture Fll Dialog (Dokuma Dolgu)

Sekil 1.6: Toolbox (ara¢ kutusu)

1.5. Vektorel Grafik Tasarim veillustrasyon Programinda
Fatura/ir saliye Reprodiiksiyonu Cizimi

1.5.1. Temel Geometrik Cizim Aragclariyla Fatura/irsaliye Olusturma

1.5.1.1. Yeni Belge Olusturma Kaydetme

Corel Draw programinda yeni dokiman olusturabilmemiz icin birkag yol birden
mevcuttur. Bunlardan birincis karsilama ekramnda bulunan New Graphic (Yeni Grafik)

simgesine tiklamaktir.
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Bir diger segenek File>New yolunu veya Ctrl+N tus kombinasyonunu kullanmaktir.
Standart Tool Bar Uzerinde bulunan New simgesine tiklamak da ayni islevi yerine

getirecektir.

£ CorelDRAW 11

Ve Tools  Help

A CorelDRAW 11, - [Graphic1]

% WEEM Edit  Wiew Layout  Arange  Effects  Bitmaps  Text T

@ Print Preview. .,

= Prink Setup...

%} Prepare For Service Bureau...

Publish Ta The Web 4
Publish To POF...

@ Document Info...,

@} Prnt Previsw, .,
b
(ﬁ‘;, Print Setup, .,

‘&}} Prepars For Service Buread,

Fublish To The Web
) Fublish To PO,
@} Ciocument Infa...

1 new-save
2 G| OKUL FATLRA
310 1.dinem 2.sinay

1 new-save
2 @OKUL FATURA
3 10-F 1.ddnem 2.sinay

B = Crlenl T — | [ new CtrbH > =
g b e AN v| | = Bk = = AR TS TR
“fg Mew From Template. .. il : ‘E Mew Erom Template. ., A
[ open.. CurkbO ||-:| ‘L%“ Uruts:glnche: J B open... oo L%]‘ Units:| millmeters  »
gﬁl Cloze @ Close i
[I‘ Save... chks L% (R Save, L (CErHS)
"@}s Save fis.,., Chrl+shife+s A @ ave fis.., ChrlShift+5
(58 revert [ Revert
1 Acquire Image ‘@ ! Acquire Image 3
ﬁl Impart... Chrl+ \‘?4 @ Import... Chrl+
L8 Bt CHIHE 0, B8 Export... ChHE
Send Ta 9 Send To »
= 4
2 print . [ 40 12 Print... o
Pririt Meras,.. @ Print Merge... 4
o,
2,

4 10. siniflar sorumluluk sinaw atdlye

W Eat A+

4 10. sinflar sorumluluk sinaw atélye

@ et Alt+F4

Sekil 1.7.8. Daha 6nce hazirlanmis olan veya kayith baska bir ¢alismayr agmak icin Tool Bar
Uzerinden Open simgesini kullanabilecegimiz gibi, File>Open yolunu veya Ctrl+0O tus
kombinasyonuna da kullanabiliriz.

Acik olan dokimammizi kapatmak istedigimizde File>Close, tim program kapatmak

istedigimizde Alt+F4 tus kombinasyonunu yada programa ait kapatma ikonunu (X)
kullanabiliriz.
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Save Drawing

Ko | 3 DR OKTAY DURAN ANADOLUME' S O (¥ | ® (-
Version;
Vession 11.0_ ¥
i S
[LI0K fodr] 8]
Flename: | Save [Kaydel] Komuid L]
Save as bype: | COR - CorelDRAW ¥ [ advenced |
Sotbype:  Default Z
Notes: | [IWeb_sale_flenames
[ Embed Forits usingT ueDoc (TM)
Save wirn ambedded VEA Prosct
[ sawe | [ Concel |

Sekil 1.9: Save drawing (¢izimi kaydetme) penceres
Acilan belge File >Save (Ctrl+S) komutuyla ¢alisilan dosyaicine kaydedilir.

File (Dosya) menusiinden Save (Kaydet) komutu tiklandigi zaman karsiniza Save
Drawing (Cizimi Kaydet) penceres ¢ikar.

Bu pencerede;

> Konum: Kaydetme isleminin bilgisayar icinde yapilacag: yeri belirler.

»  File Name (Dosya Ismi): Kaydedilecek dosyaya verilecek adin yazilacag
yerdir.

> Save as Type (Kaydetme Tipi): Kaydedilecek dosyanin hangi dosya
formatinda kaydedilecegini belirler.

»  Sort Type (Siniflandirma Tipi): Dosyanin hangi sinif altinda kaydedilecegini
belirler.

> Keywords (Anahtar Kelime): Kaydederken bagka formatta kaydediliyor ise
anahtar kelime.

> Notes (Notlar): Kaydedilen dosya hakkinda yazabilecegimiz notlari.

»  Version (Surum): Dosyanin kaydetme versiyonunu (strimind) belirler.

>  Thumbnail (Onizleme): Kaydedilen dosyanin 6n izleme dosya 6zelliklerini.

»  Advanced (Géismis): Gelismis kaydetme segeneklerini.
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>

>
>

Selected only (Yalmz Segili): Bu secenek sadece, Save komutu secilmeden
Once belgenizde nesne segiliyse gorinur hale gelir. Bu segenek sectiginiz
nesneleri kaydetmenize imkan verir.

Web_safe filenames (Web Dosya ismi): Belgeniz Web ortaminda
kullanilacak ise dosyamz adlandirildiginda bos yerlere otomatik olarak alt cizgi
karakterleri yerlestirir.

Embed Fonts using TrueDoc ™ (Fontlar1 Gom): Eger kaydedeceginiz dosya
Ozel fontlar igeriyorsa bu fontlari bu segenek yardimiyla dosyaya gomebilir ve
diger bilgisayar ortamlarinda ¢alisirken font problemi yasamassinmz.

Save with embedded VBA Project (Projeleri Gémerek Kaydet): Scriptleri
belgeniz ile birlikte depolamanizaimkan verir.

Save (Kaydet): Kaydet komutunu verir.

Cancel (Vazgeg): islemden vazgegmeyi saglar.

1.5.1.2. Gorsel Ogeleri Programa Aktarma

Dosya olusturulup kaydedildikten sonra birebir kopyas: yapilacak Fatura/irsaliye
programa aktarilir. Bunun igin File >import (Al) (Ctrl+R) komutu kullanilir. Cikan diyalog
kutusundun Import Document (Dokiman Al) (fatura/irsadiyenin ya da kullanilacak
amblem-logonun alinacag: dosya (konum) segilerek program icine alinir.

11 - [Graphic1]

A CorelDRAW

¢ JEDR ek wew Layout arenge Effects Btmeps Test 1 —
T 11— X

I.A%nw o O el L Hos oo

B gese — 'ﬁm'
neE S,
A B save is... Chri+Shift+5 rsaliye slemantan

J|j‘d !
ﬁ\ ncguirelmm 4

ot i ()

T »
@i Flvwn [0V FATURA o
%\H Prk Merge.. , Filas of ype: | AL Fle Formats ¥ [Fuimage ¥
Q Sottype | Detaul

A &mw £ [Dotae L]
W[4 Freporer Eiawald Image size: 10523 1447 Pinels , 16,7 Million Colors [32:bit) [ Link bkmap sviarialy
%‘ p._ﬂi;hrnmﬁeh 3 File format  JPG - JPEG Bitmaps JPEG Compression ikl LM g
Q. Motes: 41T peal

@Dmmﬂ*“o 7] Check for Watermark

‘ 1 GHOKLL FATURA ] Do ot show fiker dislog
! 2 10+ 1.ddnem 2.sinav Link 1o hugh 1eoluticn fie for cutput weng 0P| Maritan lagers and page

310, sinflar sorumiuluk sinav: atblye -
39 sd sonmhah ey (moot J [ cocet ]
Alt+F4

f

Sekil 1.10: Import (Programaresm alma)
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1.5.1.3. Fatura/irsaliyeyi Arka Plana Atarak Cizime Hazir Hale Getirme

Backround (Arka Plan) kilitlenen resim artik sayfa alamnda hareket ettirilemez.
Bdylece ¢izim daharahat yapilabilir.

3 CorelDRAW 11

[G:\OKUL FATURA.cdr]

% fe g% vew Lsvok Amage Effets Bimaps Iet Todk  Wndow Help Bifalk)
lopeasnne- - |@ain -8
Bl —F ] Y e T el N
S T SO0 VT 01 00 JNC TV DOE eI O e, O IO SO O TR ]
2
&,
Q
oM
al il Cizimi Yapil acek
a \ == ———{—> Orijind irsdiyeli Fatura
Xi" s f v
 E—— |
o
&5 1
e
& V"'“"*"V— e 7
FRESTI RSN T T Ll
™

Basglat

Sekll 1 12 Orumalm ar ka plana (background) atilmasi

CorelDraw programinda arka plana atilan resimin kilitlenmes islemi sag tusa
basilarak L ock Object (Objeyi Kilitle) komutu tiklanarak gerceklestirilir.
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O Convert To Curves Ctrl+Q
Symbol >

Break Apart

E \Wrap Paragraph Text

LD Undo Move Ctri+Z
K cut Chrl+x
% Copy Ctri+C
?ﬁ; Delete Delete

Save Bitmap As...

Order >
Styles >
Internet Links 3
Jump to Hyperlink in Browser

Q Overprint Fill

@ Overprint Qutline
Properties

Sekil 1.13: L ock object objekilitleme penceresi

1.5.1.4. Cizimlerin Olusturulmas

Pick Tool (Segme Araci): Nesneleri segmeye ve tasimaya yarayan aragtir. Pick araci
seciliyken bir nesnenin Uzerine tek tiklachgimizda o nesne Uzerinde nesnenin, koselerinde,
alt-Ust ve sag-sol yanlarinda biyultme, kiglltme, cift tiklandiginda egme ve dondirme
islemleri pratik olarak yapilabilmemiz icin baglantt noktalar1 belirir. Bu baglant:
noktalarindan mouse’'un sol tusuna basili tutarak degistirdigimiz zaman 6zellikler
degisecektir. Bunu ekran Uzerinde gorebiliriz.  Shift tuslarina  basili  tutularak
degistirdigimizde degisiklikleri simetrik olarak gerceklestirecektir.

Pick Tool
[Secim Arac)

&
Sekil 1.14: Pick Tool (Segme) araci

Ayrica Pick Tool araci ile pratik olarak kopyalama islemini de gergeklestirebiliriz.
Nesne secili iken bir yerden baska bir yere tasima sirasinda mouse’ un sol tusunu birakmadan
sag tusuna bir tiklama yapildigi zaman kopyasi ¢ikarilmis olur. Eger nesnenin simetrik
olarak kopyasini ¢ikarmak istiyorsak Ctrl tusuna basili tutarak istedigimiz tarafa yine sol
tusu birakmadan sag tusa tek tiklamaile simetri kopyasin ¢ikarabiliriz.

Cizimi gergeklestirilecek Irsaliyeli Fatura orijinai CorelDraw ¢izim sayfasina

alindiktan sonra, arag kutusunda bulunan Rectangle (Dikdortgen Araci) yardimu ile
dikdortgenleri cizeriz.
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Rectangle (Dikdortgen Arac): Dikdortgen gizmek igin kullanilir.

FPoint Redtangle
{3 nohteh dutdrtgen)

Redt=angle
[Dudortgen)

Sekil 1.15: Rectangle Arac kutusundan (dikdortgen) aracimn segilmesi

Ctrl tusuyla birlikte kullanlirsa kare elde edilir. Uzerine Pick Tool (Segme Arac) ile
tek tiklayip sectikten sonra Sag tusa basarak cikan menude en altta bulunan Propertis
(Ozellikler) secenegi tiklamrsa. Bu dikdortgen (izerinde yapabilecegimiz degisiklikleri
gosteren yardimci pencere ¢ikar. Buradan dolgu, ¢izgi, genel, internet, dondirme, ételeme
ayarlarim  gergeklestirebiliriz. Burada Rectangle (Dikdortgen) segeneginden Corner
Roundness (Kdse Acilart) yardimu ile kose degerlerini 15 derece veririz.

Dikdortgenin kdse agilarimin verilmesinin diger bir yontemi de, Pick Tool (Segme
Araci) ile c¢izmis oldugumuz dikdortgeni segtigimiz zaman Property Bar Rectangle
(Dikdortgen Secenekleri) ment cubugunun aktif oldugunu goririiz. Buradan Rectangle
Corner Roundness bol imiinden istedi gimiz kdsenin agisim 15 yapabiliriz.

EA CorelDRAW 11 - [D:\OKUL FATURA.cdr]

[% e Edt wew Lavow avange Effects Brmaps Tet Toos  window el NEES

loppexaae « @aie @«

/54904 (75 148 mm 3| % - |[15 ®&|F 1 @ =
[sftam it RS ® [ ok o |SIfEalt JMEed® ) afrie W@ o0 |
O LA SO (O e . e B TS » Object Propates x|gg
= I ]
[ Rectangle Corner Roundness
i v
7] - LJ -
7 . : car
%y
Q L] L] L]
& (88
B,
A % [IBehind fil
a, [ Scale with image
I 2
Q 34
~ &
V)
)
2
81
i ®
!‘ II ppl e
4% W 4 7of15 » W) Page? (Pagel 7 Paged J Pege 10 &) m [ N (&) L)
Width: 75.148 Height: 27.197 Center: (64.904, 216.006) milimeters Rectangle on Layer 1 & None >
[126.009,296.916]  Click an object twice for rotating/skewing: dbl-clicking tool selects all objects; Shift+click multi-selects; Alt+click digs: Ctileclick selects in a group Q Black Hailine -

] Fatura-frsaliye Modil. .. B CorelDRAW 11 - Moon Tirkge Dil K...

Sekil 1.16: Dikdortgen kose agilarinin verilmesi
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Point Rectangle (3 Noktalh Dikdortgen): Ozel ozellikleri olan dikdortgenler
olusturur.

Not: CorelDraw programinda herhangi bir segili objenin Gizerinde mouse’ umuzun sag
tusuna tikladigimizda o obje ile ilgili yapabileceklerimiz ve en atta Propertis (Tercihler)
penceres karsimiza gikmaktadir.

A CorelDRAW 11 - [D:\OKUL FATURA.cdr]

¥ Ele Edt Yew layok fmenge Effedts Btmeps Iet  Took  Wndow  Help -8 x
pRRKER e -i'|§Q||E|=“ e

H‘—i Fﬂ\ :9 ‘)III | i’~::{]‘l|*ﬂ @ |@ 20|

i

T G g s T i

ﬁ:

Re les Tool (F6

150 E
EAE o o

cEESE &wm@pmrv“l

100
aibis

_E:K< 6o/10 ¥ M [ FageZ J Faged ] Paged J Page’ ) Page 6 /Fd @ [ |
Rectangle on Layer 1 &
[-191.115. 247,621 )  Dblclick tool creates a page frame; Cli+drag constrains to a square; Shit+drag diaws from center (@ 0.216 paints

Sekll 1.16: ledortgenlerln gizimi

Kare ve dikdortgen cizimi gerceklestirildikten sonra elemanlar birbirlerinden istenilen
uzakliklara yerlestirilir. Bu islem icin Arrange >Transformations (Tasima) Paneli
kullanlir.

Transformations (Tasima) paneli yardimiyla nesneler, birbirlerine olan uzakliklarin
ayarlayabilir.

Not: Biz Ornegimizde cizdigimiz diktorgen ve kareyi sol Ust kissmda hizaladiktan
sonra karenin dikdortgenden 6l¢llU olarak uzaklastirma islemini uygulayacagiz. Bu islemi
gerceklestirmek igin Transformations panelinin yamnda Align (Hizalama) panelini de
kullanacagiz.
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Align (Hizalama) Paneli: Bu panel yardimi ile segili bulunan nesneler birbirlerine
gore dtta, Ustte, yanlarda hizalanabilir. Hizalanmak istenen iki nesne segildikten sonra,
burada dikkat etmemiz gereken iki nesneyi secerken Shift tusuna basili tutmamz ve
hizalanacak nesnenin sabit durana gore ilk 6nce segim isleminin yapilmas: gerekir. Nesneler
secildikten sonra Arrange > Align and Distribute > Align and Distribute panelini

Segeriz.

¥A CorelDRAW 11 - [DAOKUL FATURA.cdr]
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Sekil 1.17: Hizanalacak nesnelerin secimi ve Align and Distribute paneli agma meniisi

Karsimiza Align and Distribute paneli cikar.
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Align and Distribute
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[ ygula ][ Cloze ]

Sekil 1.18: Align and Distribute (Hizalama) paneli

Secilen nesneler panelden Top (Ust) ve Left (Sol) kutucuklar isaretlenerek uygula
dugmesine basilarak sol Ust kdsede hizalanir.

B CorelDRAW 11 - [D:ADKUL FATURA.cdr]

‘ % Fle  Edit  Wiew  Layout Effects  Bitmaps  Tewt  Tools  Window  Help - E? X
H LB e %|$ B %| || Bostion Alk+F7
;(\ Clear Transformations Raotate E o -
‘ ; i "I" S ‘ [ &lign and Distribute | Scale A+F [ B | = ‘
] 10 Crder Yo 3 AlELD 200 0 00 30 milimate
i 1 o Skew li i L I oot
—z i Group Chrla = =
ke (%, Lingroup ikl
{ﬁ‘ %% Ungroup &l o i
p‘ [gh Combine Chrl+L
&z ) Break Apart
| B
Lock Object
o & Lockob
) Unlock Object
g: i Unlock All Cbiscts
E - Shaping 4
A ¥ Corrert To Curves chl+Q
By 2 Corwert Outine To Object CtrbShift+G)
l Clase Path 4
EAER
aQ = n x [] Relative Position g
7 =
Y ooo o
2, Oen
&y oon0
Apply To Duplicats
| | n n
-
4 gy
eI Eoi1z v M f Page? f Paged J Paged J Page§ 3 Page® fFd ¢ ) @)y
2 Objects Gelected on Laper 1 P e
[13.231, 313564 Click an object twie for ratating?skewing: dbkolicking too! selects all objects; Shift+click multi-sslects: Altsclick digs; Ciiklick selects in a group Q >

s Baslat Ckee  EACo.. | = Moo, | SHFa., |6 Fab.. | ol Fa., | 8 ook 8| Fat .

Sekil 1.19: Transfor mations paneli

20



Daha sonra Arrange>Transformations menisiinden Position (Pozisyon) acilir.
Acilan panelde Position, Rotate (Dondirme), Scale and Mirror (Blyitme ve Y ansitma), Size
(Buyuklik), Skew (Egriltme) secenekleri cikar.

Biz drnegimizde tasima, bir diger adiyla 6teleme yapacagimizdan Position segeneginin
aktif olmasi gerekmektedir.

Buradan; H: Horizontal (Yatay), V: Vertica (Dikey) olculerini vererek Apply
(Uygula) komutu yarcimyla karemizi dokdortgenimizin istedigimiz bir bdlgesine
tasiyabiliriz. Eger Apply To Duplicate (Cogaltarak Uygula) tiklamirsa, cogaltma islemi
yapilarak tasinir.

Uygulamamizda H: 20 mm V: 95 mm oOlculeri verilerek Apply (Uygula) tusuna
bastigimizda kigik dikdortgenimizi, buyik dikdortgenimizden uzaklastirmus oluruz. ki
dikdortgen arasinda birakilan bosluklar yukarida 95 mm; cilt pay: olarak gerekli boslugu ve
gerekli bilgiler icin ayrilmus yeri gosterirken, sag tarafta birakilan 20 mm; tasarim ve
dosyalamaislemi sirasinda gerekli olan alam ifade eder.

Not: icte bulunan kiigik dikddrtgenimizin boyutlar:; H: 160 mm, V: 145 mm, biiyiik
dikdortgenimizin boyutlart ise; H: 195 mm, V: 270 mm'dir. Buyik dikdortgenimiz
Irsaliyeli/Faturamn sayfa boyutunu gostermektedir.

1.5.1.5. Yatay ve Dikey Cizgilerin Cizilmes

Freehand Tool (Serbest Cizim Araci) mouse ile tiklanarak alindiktan sonra cizilecek
Gizginin baslangi¢ noktasina bir kere mouse sol tusu ile tiklamir ve gizginin bitis noktasina
kadar goturulerek tekrar sol tus ile tiklandigi zaman istenilen ¢izgi ¢izilmis olur. Burada
birinci tiklamadan sonra diiz yatay bir ¢izgi cizilecek ya da diz dikey bir cizgi cizilecek ise
Ctrl tusuna basilarak cizim yapilirsa gizgilerimiz yatay ve dikey olmak Gzere tam diiz bir
olur. Mouse' un sol tusuna basili tutarak ¢izim yapilirsa serbest ¢izgi cizilmis olur.

Feehand (Serbest Cizim)
9 Bezier (DUgum Noktasi)
A Artistic Med ia (Ssli Yazi)
‘ Ren (Kalem)
e‘ H“’? 2B AsH I"-‘% Dimension (Boyutland ima)

Interactive Connector
(Baglanti Cizgileri)
q 3-Point Curve (3 Noktall Egri)
[

Rolyline (Sanatsal Cizim)

Sekil 1.20: Freehand Tool (serbest ¢izim arac)
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Cizilmis olan cizginin boyutunu ayarlama islemi, cizgi Pick Tool (Secim Araci) ile
secildikten sonra Property Bar: Curve or Connector (D6ndirme ve Bikmek Tercihleri
Cubugu) yardimu ile yapilir. Yine buradan cizgimizin boyutunu ve punto kalinligim da
ayarlayabiliriz.

Scale Factor (Olgli Mizdes)
Fck Tool (Se¢im Aracl)ile segilmisolan

objeleiin sikstrimasiniayatar.
! ke Y Auto Close Curve

Object(s) 9ze (Objelerin Biyukiug ) Mirror Buttons (Ayna Butonlari) (Otomatik Ara Doldurma)
Ack Tool (Se¢im Arac)) ile segilmigolan Scili objeyi aynalama yontemi Ag iltbulunan ¢izginin uglarini
objeleiin genislik ve ylksekligini ayarar. ile terddiizetmeye yarar. birle gtirir, kapatir.

X

Property Bar: Curve or Connector 3]

/103,605 mm | *+ 145,808 1000 % (g -~ Al@ —mC s p
s im0 120 oo [[% /0| —BIEHIE B 88 of B
! ! !
Sart Arowhead selector

Object(s) Position (Objelerin Pozsyonlar) Anglle of Rotation (Cizginin basina ok) Outline Width (Cizgi Biyuklag i)
Ack Tool (Se¢im Arac ) ile segilmisolan (Dondirme Agis) Secili  Outline Syle Selector Cizgilerin puntolarmi ayariar
objelein merkezlerinin xve y objenin déndimme (Cizgi Sttilletini Seg er)
koordinatlarnauzakligini ayadar. ilem ini ger e Ke stirir. End Arowhead selector

(Cizginin sonuna ok)
Sale Factor (Olgli Mizdes) kilidi

Sekil 1.21: Property Bar: Curveor connector (déndir me ve bukmek tercihleri paneli)

1.5.1.6. Renklendirme Y apmak

Corel Draw programinda nesneleri renklendirmenin birkag yolu vardir. Arag kutusunda
bulunan Dolgu Rengi Dialog (Fill Color Dialog), dolgusu verilecek nesne tizerinde pick tool
(secim araci) ile sag tus tiklanarak properties (tercihler) agilarak Object Properties (Obje
Ozellikleri) dolgu rengi verme ve calisma penceresinin sag yaninda bulunan renk pal etinden
dolgu renginin yan sira nesnenin ¢izgi rengini de verebiliriz.

Dolgu rengi verilecek nesne pick tool araci ile secili iken renk paletinden hazir
renkleri segerek dolgu rengini verirken, yine nesne segili iken renk tzerinde iken mouseun
sag tusuna tikladigimiz zaman segmis oldugumuz renk nesnenin ¢izgisine uygulanir.

Ayrica renk paleti Uzerindeki renk kutusu Uzerinde mouseumuzu basili tutar isek o
renk ileilgili renk gecislerini gosteren pencere agiga ¢ikar. Buradan vermek istedigimiz tona
gore rengi tikladigimiz zaman secili nesnemize rengi vermis oluruz.

NOT: Nesne secili ve herhangi bir renk uygulanmis iken Ctrl tusuna basili tutarak

baska bir renge basar isek ilk renge, her basista % 10 oraninda yeni bastigimiz rengi eklemis
oluruz.
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Fll Color Dialog (Dolgu Rengi Dialogu)
ﬁ‘ Fountain Fill Dialog (Gegis Rengi) EIEX]
’7 . Color Docker Window

&‘ H " L Eﬂ s )(| i (Renk Renceres)

L L No FAll (Dolgu iptal)
Qé”q PostScript Fll Dialog (Dipnot Dolgu) 0 A

Texture Hll Dialog (Dokuma Dolgu)

Object |"I'|l['l|"| es

>ammigm
HEEEEX

Urifarm fill

My

)

Sekil 1.22: Dolgu ve cerceve rengi araclari

Renk araglarindan hazir renkler secilebildigi gibi Uniform Fill (Diuzeli Dolgu) ve
(Mixser) panelinden de gesitli renkler olusturularak direkt nesneye verilebilir.

Renk karistincidan (Color mikser) elde edilen renk, Add to Palette (Palete Ekle)

komutu ile palete eklenmis olur. Boylece programda caistigimiz sirece kullandigimz
renkler kayitl kalir veistedigimiz renge rahatlikla erisebiliriz.
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Sekil 1.23: Renk karisim (Mikser) paneli

Cizilen ve renklendirilen nesneler birbirlerinin altinda kalabilir. Orijinale gore cizilen
nesneleri konumlandirmak icin Arrange > Order komutundan yararlamlir. Bu komut
altinda yedi segenek vardir. Bunlar:

3 CorelDRAYY 11

‘
'

1.5.1.7. Konumlandirma Y apmak

[DAOKUL FATURA.cdr]

¥ Fle Edbt  Yiew Layout Effects  Bitmaps Text  Tools  Window  Help
B @ @ %|g % %| Transformations PH
')*"O Clear Transformations
I.ZSA.E_DZIJ]D]_IHIJ_EJZE_DJD].H e R g
w32 444 mm | E 45092 mm &19n and Ustriute
o |nn E: .: To Front
— ‘R Group crrles (B ToBack Shift+PgDn
(R 3 3 Ungroup cil+l | ForwardOne  CirkPolp
% %% Unaroup Al &) Back One CkrH+PgDn
|
9 B- Igh Combine colsl |G InFront OF.,
é\," Eh Break Apart P Behind...
i [ g Lack Object % Reverse Ordar
= & Urlock Object
=
9_4 a7 ﬁ Irlock all Objects
G) Shaping 4
@ E v Conyert To Curves ChrHG
& - gij Conyert Qutline To Objeck Crr-Shift+0
el |
a i Closs Path 13
M

Sekil 1.24: Konumlandirma (Arrange > order) secenekleri
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To Front (En Uste Cikar): Secili olan nesneyi aym katmandaki tiim nesnelerin
Ustiine cikarir.

To Back (En Alta Koy): Secili olan nesneyi aynm katmandaki tim nesnelerin
atinakoyar.

Forward One (Bir Uste Koy): Secili olan nesneyi bulundugu konumdan bir
adim 6ne tagir.

Back One (Bir Arkaya Tas1): Secili olan nesneyi bulundugu konumdan bir
adim arkaya tasir.

In Front Of (Secilenin Oniine Koy): Bu komut secili nesnenizin yerini
degistirmenize ve onu gegerli katman siralamasinda belirtiginiz herhangi bir
nesnenin Oniine getirmenize olanak saglar.

Behind (Arkaya): Bu komut da ekrana, sectiginiz nesnenin gecerli nesne
siralamasinda hangi nesnenin arkasinda yer alacagim belirler.

Reverse Order (Tersine Sirala): Sadece sectigimiz nesnelerin katmanlarda
yerlesim sirasin degistirir.

1 '

Sekil 1.25: Katmanlarin sirasini degistirme

1.5.1.8. Yaalarin Olusturulmas

Yazilarin olusturulmast asamasinda, Yazi Araci (Text Tool) kullanilir. Bu aract
sectikten sonra bog bir alana bir kez tikladiktan sonra Artistic Paragraf (SidU Yazi) alanm
acilir. Buradan paragraf olusturmayan yazilar yazilir. Eger ara¢ secilip tiklamadan sonra
mouse birakilmayip belli bir dikdortgen cizerek birakilirsa paragraf yazi alan acilir. Artistic
paragraf yazinin rengini ve puntosunu degistirmek igin pick tool (se¢im araci) yardim ile
secildikten sonra Property Bar Editing Text (Yazi Dizenleme Segenek Paneli) yardim ile
degisiklikler yapilabilir. Yazinin rengini degistirmek icin yazili alan segili iken ekranmin
saginda bulunan renk paletinden yararlanilir.
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Y az1 araciyla agilan alana metin girisi yapilir. Yazi Formati (Format Text) Panelinden
ya da direkt metin kutusuna muidahale ederek yazi tipi, boyutu, satir/harf araigi gibi
ayarlamalar yapilir. Burada 6nemli olan orijinale birebir uygunluktur.

Syle To Edit Font List Font 9ze List Aingnment msimayan
(qil Diizenler) (Font Listes) ~ (Font Biytklik Listes) (Hizamalam) Mad;inf Karakerler

Property Bar: Text

2| |G DetaPasgrepn Tewt (9| [T AvenGacekeT @12 | B IU | &= if|=’§%§ 1|r b Edit Bxt

@z Diizeni)
Bold (Kalin)| \ |
) taic (5 jceriden Dop Cap
Syle Lis Underine (A Gizg)  Dgardan  (Dsarda (o' =
(Sl Listes) tr Brakma) g

=)
BT

_ (Yaz Aracl)

U,

Dikey Genigetme
Ttamaci

Yatay Genigetme

Dr. TOktay DDu:rgn Matbaa TF Yime

Kelime ve Harf Mekez Bgma Boyutiandirma
Kaydrma Tutamaci Tutamaci Tutamaci

Metin Alanini Dikey Boyutlandima Metin Alanini Boyutlandima

Ttamaci Tutamaci
JJ_.\ Melkez B.gma ‘
n

Tutamaci
Yazi araciyla acllan alapia metin gitisi yapilir
Yazi Format (Format Text) Panelinden ya da Metin Aanin
=direkt metin kutusunaxmiidahale ederek yazis—taay Genigetme
tipi, boyutu, sativharf araligi gibi ayarlamalar Ttamaci

yapilr. Burada dnemli olan orijinale birebiriljrfn/:!asﬁcma
"""""""""""""""""""""""""""""""""""""""""""""""" s amaci

L} |_T_] .
: p Satr Aas Acma
Metin Alanini Dikey Boyutlandirma Ttamact

Ttamaci

Sekil 1.26: M etin kutusu ayarlari
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Yazilar orijinale birebir uygunlukta hazirlanip yerlestirildikten sonra cizim (yol)
haline dontsturilmelidir (Convert to Paths). Bunun nedeni, hazirladigimiz iste bulunan yazi
karakterlerinin herhangi bir baska bilgisayarda bulunmama olasiligidir. Eger bu komut
verilmezse ve kullandigimiz fontlar mevecut degilse yazilar bozuk ¢ikacaktir.

Yazilart yola donustirmek icin, yaziy1 segtikten sonra Text>Convert to Curves

(Ctr1+Q) komutunu vermek yeterlidir.

1.5.1.9. Yaziyr Seklin Etrafinda Dolastir ma
Buislemicin gerekli ¢cizim araci ile sekil ¢izilir. Daha sonra Text (Y azi) aract ainarak

seklin cizgi Uzerine yaklasilir. Pick Tool araci asagidaki sekle donlstligli zaman mouse ile

tiklanmir ve seklin etrafinayazi yazilmaya baglanir.

o

—
—

Sekil 1.27: Yaziy1 obje tizerinde egme
Yaz1 yazildiktan sonra tekrar pick tool araci secilip yazi segilirse Text on Curve /
Object (Obje Ustlinde yaziy1 ey) panelinden gerekli ayarlar yapilir.

1.5.1.10. Elemanlari1 Gruplama
Cizimler, yazilar ve diger ayarlamalar bittikten sonra elemanlarin gruplanmasi gerekir.
Bunun igin Arrange>Group (Ctrl+G) komutu kullamlir. Eger grubu bozmak istersek

Arrange >Ungroup (Ctrl+U) komutunu vermemiz yeterlidir.
Bu son islemden sonra backgroundun kilidini acip silebiliriz.
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(' UYGULAMA FAALIYETI

o :
seAl AsRano
e — L SEVK T
[ el wikrans | ol rtvan | ruam
oV s
[P e e
AL L R TR A e 1L ORNER

Y ukaridaki irsaliyeli faturay: asagidaki islem basamaklar: ve oneriler dogrultusunda

Giziniz.

islem Basamaklari

Oneriler

» Verilen orijinalleri bilgisayarimza
aktarinz.

» Vektorel cizim programi CorelDraw’ da
yeni bir belge aginiz.

> Belgeyi ism vererek  kaydediniz
(File/Save).

» Cizeceginiz irsaliyeli faturayr programa
alimz (File/lmport).

» Size verilmis olan dijital orijinain
¢OzUnurl tgtnuin yiksek olmasina dikkat
ediniz.

» File/New komutunu ya da Ctrl+N kisa
yolunu kullanmmz.

» Actigimz belgeyi isin adiyla ve dogru
klasoriin  icine  kaydetmeye 0©zen
gosteriniz.

» File/lmport komutunu kullaniniz.

28




> Irsaliyeli faturay: arka plana atiniz.

s

o
o

> Rectangle" ve frechand tool aracini
kullanarak sayfa boyutunu, dikddrtgen ve

dikey-yatay cizimlerini yapiniz.

»

|

» Cizimleri renklendiriniz.

|

mentstnid  kullanarak

» Import logoyu

» Arka plana attigimz irsaliyeli faturay:
daha rahat c¢izim yapabilmek icin
kilitleyiniz.

» Cizimleri yaparken dogru araglarn
kullanmaya 6zen gosteriniz.

» Kirik olmayan temiz ¢izimler yapmaya
dikkat ediniz.

» Renklerin orijinal ile birebir uygunlukta
olmasina dikkat ediniz.

» Alinan logonun kaliteli olmasina dikkat
ediniz.
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sayfaya aimz. Dare gevresine yaziyi
yazinz.

» Yaazlar olusturunuz.

‘Qﬂ

W

oA e
utiian b

T

HHH

o

> Yazilar convert ediniz.

» Elemanlar gruplandirinmz.

» Yazilarin orijinal ile aym font ve
puntoda olmasina dikkat ediniz.

» Baska bilgisayarlarda sorun
yaratmamasi i¢in yazilar: convert ediniz
(yola donustiriniz).

» Modify/Group komutunu ya da Ctrl+G
kisa yolunu kullaninz.
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(' UYGULAMA FAALIYETI )

Asagidaki sorular igin dogru olan sikki isaretleyiniz.

Asagidakilerden hangis vektorel cizim programlarindan birisidir?

A) Word
B) Excd
C) CorelDraw
D) PhotoShop

Asagidakilerden hangis faturamin iginde yer alan 6gelerden birisi degildir?
A) Maliye Bakanligi Muhri

B) Cins

C) FirmaVergi Numarast

D) FirmaReklam

Satilan emtia veya yapilan is karsiliginda misterinin borglandigi meblagi gostermek
Uzere emtiayr satan veyaisi yapan tliccar tarafindan misteriye verilen ticari vesikadir.
Y ukarida tamm yapilan ticari vesikanin adi asagidakilerden hangisidir?

A) Irsaiye
B) Fatura
C) Makbuz

D) Gider Pusulasi

Satilan malin veya satin ainan malin, tasinmasi sirasinda diizenlenen belgedir. Malin
nereye ve kime gonderildigini bdlirtir. Yukarida tamm yapilan vesikamn adi
asagidakilerden hangisidir?

A) Makbuz
B) Fatura
C) Irsdiye
D) Fis

Pick Tool aracimin karsilig1 asagidakilerden hangisinden dogru verilmistir?
A) Cizimarac

B) Secimarac

C) Kesmarac

D) Boyamaarac

Dokiimanimizi kaydetmek icin hangi ment komut dizinini kullamriz?

A) FileeNew
B) File>Save
C) Fileslmpart
D) File>Open
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7. Font niteliklerinden birini belirten “Bold” teriminin Turkge karsilig1 asagidakilerden
hangisidir?
A) Kaln
B) Ince
C) Egik
D) Da
8. Nesnelerin hizalamaislemi hangi pand yardimu ile yapilir?
A) Align and Distribute
B) Transformation
C) Color
D) Properties
9. Asagidakilerden hangis bir dikdortgen ¢gizim aracidir?
A) Pen
B) Line
C) Knife
D) Rectangle
10.  Yaalarin baska bilgisayarlarda bozuk ¢ikmamasi icin ne yapilir?
A)  Uzerinden gegilir.
B) Turkge karakterlerle yazilir.
C) Puntolari mimkin oldugunca biydltaldr.
D) Yaalaraconvert to path (yola donusttr) komutu verilir.
11. Duzvedikey cizgiler gizilirken hangi arag kullanilir?
A)  Pick Tool
B) Polygon Tool
C) OutlineTool
D) Freehand Tool
DEGERLENDIRME

Cevaplarimizi cevap anahtar ile karsilastirimz ve dogru cevap sayimzi belirleyerek

kendinizi degerlendiriniz.

Olgme sorulanndaki  yanlis cevaplanmz tekrar ederek, arastrarak ya da

Ogretmeninizden yarcim alarak tamamlayinmz.
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DEGERLENDIRME OLCEGI

Ogrenme faaliyetinde kazandigimz becerileri asagidaki tablo dogrultusunda 6l giiniiz.

Performans Degerlendirme Evet Hayr
Orijinali bilgisayariniza aktardinz mi?

Y eni bir belge agtimz mi?

Belgeyi dogru sekilde kaydettiniz mi?

Gorsel 6geleri programa sorunsuz aktardimz mi?
Cizilecek gorseli arka plana attimz mi?

Cizimleri sorunsuz yaptiniz mi?
Renklendirmeleri dogru ve sorunsuz yaptimz mi?
Logoyu sayfaya aktardimz mi?

Y azilar1 sorunsuz yazdiniz mi?

Y azilar1 convert yaptimz mi?

Elemanlar gruplandirdimz mi?

Faaliyet degerlendirmeniz sonucunda hayir isaretleyerek yapamadigimz islemleri
tekrar ediniz.

Tumislemleri basariyla tamamladiysaniz bir sonraki faaliyete geciniz.
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OGRENME FAALIYETI-2

( AMAC )

Bu faaliyet ile gerekli ortam saglandiginda; cikis alarak kontrolleri yapabilecek,
tashihleri gerceklestirebileceksiniz.

(' ARASTIRMA )

Cikis cihazlarint inceleyerek matbaacilikta hangi amaclar icin  kullamldiklarin
arastirimz.

2. CIKIS VE KONTOL

Matbaacilik alaninda yapilan isin provasimn alinmas: ve misteriye onaylatiimas: ok
onemlidir. Bunun nedeni, bilgisayar ortaminda hazirlanan isin orijinale birebir uygunlukta
olmasinin saglanmasidir. Amblenvlogoyu olusturan cizgiler, yazilar ve renk degerleri
kopyasi yapilan orijinalle aym degerleri tasimalidir. Bunun kontrol i de ¢ikis alinarak yapilir.

2.1. Yazia Cesitleri Ve Ozellikleri

Yazicilar, yapilan galismalarin gerek tashih, gerek prova, gerekse baski igin film
olarak elde edilmesini saglayan cihazlardir. Yazicidan elde edilen hard-copy ya da hard-
proof denilen Uriin provalari renk ve tasarim provasi icin kullanilir. Matbaacilik icin oldukca
onemli olan filmler de gene bu cihazlar ile elde edilir.

2.1.1. Murekkep Piskirtmeli - Ink-Jet Yazicilar

Sivi haldeki mirekkebi kgt tzerine plskirterek gorintt olusturan yazicilardir. Basit,
sadece ev icin olanlart oldugu gibi oldukca kapsamli ve pahali olanlari da vardir. Bunlar
matbaacilikta prova amagli olarak kullamlirlar. Cok degisik yuzeylere bask: yapabildigi igin
elde edilen provalar oldukca gergekgidir.



Sekil 2.1: M urekkep puskirtmeli yazia

Dezavantgjlarindan biri kullandiklari mirekkebin ¢ok cabuk bitmesi ve kartus ach
verilen mirekkep haznelerinin ¢cok pahal1 olmasidir. Bu yazicilardan AO ebadina kadar Gikis
alinabilmektedir.

2.1.2. Termal Transfer-Dye Sublimation-Solid Ink Yazicilar

Kabaca kat1 haldeki mirekkebi 1st yoluyla k&git Gzerine aktaran yazici gesitleridir.
Genelde 6zel kégitlar Uzerine baski yaparlar.

2.1.3. Lazer Yazcalar

Lazer yazicilar, su ana kadar Uretilenler icinde hizl1 ve kaliteli baski yapabilen en iyi
yazicilardir. Uretildiginden beri masalisti yayincilik alamnda vazgecilmez bir aractir.
Ozellikle aydinger ve asetat tizerine ¢ikis alinabilmesi 6nemli bir 6zelligidir. Bu yolla kitap,
cizelge gibi tek renkli tireislerin kalip gekimi mimkindur.

Birgok Ozelligi ile fotokopi makinelerine benzeyen bu aletlerle cok kaliteli baski
yapmak mumkindur. Ayrica bilgisayar ile haberlesmesini saglayan bir dil (Postscript, PCL
ve Ouick Draw) bulunmaktadr.

Sekil 2.2: Lazer yazic
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2.1.4. Lazer Pozlandiricilar - Image Seter

Hassas, detayli ton gegisli resim ve islerin cikisinda kullamlir. Lazer 1sigin filmi
pozlandirmas: ve bu filmin banyo edilmesi sonucu ¢alismalarin baski igin film cikisi elde
edilmis olur. Y Uksek ¢ozunurl UklG hassas cihazlardir.

Lazer pozlandincilar, yazilhm makineleri ve film, kagit vs. Uzerine bilgisayarda

hazirlanan, yazi ve sekillerin c¢iktist amada kullanilir. Cikti materyali olarak film
kullanildiklarindan gok yiksek ¢ozinurltkte ¢ikis alinabilir.

2.2. Cikis Ayarlari

Cikis islemleri icin baslica iki komut kullamlir. Bunlar; yazici segiminin yapildigi
File> Printer Setup (yazici ayari) ve c¢ikis ayarlarimn yapildigi File>Print  (ctrl+P)
komutlaridir.

File>Print komutu ile ulastigimz pencereden;

Print ‘X

General | | ayout | Separations | Prepress | PostScrint| Misc | & 5lssues|
Destination

MName:

Type: Use PPD
Status:

‘Where:

Comment: APinttafie [
Print 1ange Copies

(® Current document () Documents Number of copies:

) Current page Selection
OE&Q::! [124 \ @EEEIE]

[Even & Deld ¥

Print style: ]Cuetum [Curent settings not saved) i] | savess. |

[ roreee JB) e I e ] oo
Sekil 2.3: Cikis ayarlar: kutusu

Bu palet yardim ile ¢ikis alacagimiz dokumanin gikis ayarlarin gergeklestiririz.

Burada; Name (isim): Hangi yazicidan cikis almak istiyor isek onu segmeye yarar.
Sistemimizde birden fazlayazici olabilir. Buradan yazicimizi segebiliriz.

Properties (Ozellik) kisminda segcmis oldugumuz yazicimn daha kaliteli cikis
alabilmesi icin 6zelliklerine gore ayarlarimin yapilmasinm saglar.
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Print range (Yazici Sirast) bdluminden dékimanimizda bulunan sayfalarin yazdirma
sirasini ayarlariz.

Copies (Kopyalar) kismindan kopya sayisim belirleyebilir.

Print style (Yazicr Stili) ve Save As (Yeni isimle Kaydet) yardim ile yazicilarimizin
ozelliklerini ayarladiktan sonra kaydeder ve ileriki bir tarihte aym 6zelliklerde ¢ikis amayi
gerceklestiririz.

Print Preview (Yizici Gosterimi) yardimu ile sayfamizin ¢ikisim almadan 6nce kagit
Uzerinde nasil gorinecegini gbrmus oluruz.

Print (Yazic1) komutu ile dokimamnmuzi yazdirilmak Uzere yaziciya gondeririz.
Layout (Plan) dan ¢ikisimzin planmn yapabilir.

Seperations ise sayfamzi renk ayrimi yaparak her rengi ayri paetlere ayirarak baski
amanizayarar.

Prepress (Baski Haair liklari) yardimu ile film ¢ikisin hazirliklarinm yapabilir.

Misc (Genel) ayarlari kismunda dokimammuzda basmay: istedigimiz nesneleri
secebilir, baski rengini ayarlayabiliriz.

Cikist dinan is kontrol edilerek duzeltmeleri yapilir veilgili kisiye onaylatilir.
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(' UYGULAMA FAALIYETI

)

Islem Basamaklari

Oneriler

aginiz.

Print Merge... 4
Print Preview...
G Print Setyp. ..
{} Prepare For Service Bureau...

Publish To The Web 3
i) Publish To POF...
@ Document Info. ..

1 OKUL FATURA

2 takvim

3 E:\SERKAN\.. \ist logo gizim
4 D:\OKUL FATURA

W Exit Alt+F4

» Yaziciy1 seginiz.

Gereral | Lapou | Separations | Prgeess | PostSorpt | Mise | 4 5 ssues!
Destinstion
e T | [P |
Tipe i L
Statsz
Wheste
Cammert P @
Part targe Copiet
(&) Curert docusent () Documerts Mumber of copus [
(0 Cunent pags ekt
= S— T T
{Event 0 ]
Fork s | Custom [Cuasend seitings nol sved) B [ seen ]
Pk Preiow 2] = T bois |[_ew

» Basilacak sayfalar: seciniz.

» Kopyasayisini seginiz

» Filelprint komutu ile ¢ikis penceresini

» Kisa yol olarak Ctl+P komutunu

verebilirsiniz.

» Cikis ayarlarini dogru yapimiz.

» Orijinde birebir uygunluga dikkat

ediniz.

» Duzeltmeleri dikkatli yapinmz.
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» Print (Baski) butonunu onaylayarak ¢Gikis
ainmz.

» Orijinale uygunlugu kontrol ediniz.

» Duzeltmeleri yapimz.
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( 6LCME VE DEGERLENDIRME )

Asagidaki sorular igin dogru olan sikki isaretleyiniz.

Sivi haldeki mirekkebi kagit Uzerine puskirterek goruntd olusturan yazic
asagidakilerden hangisidir?

A) Lazer Pozlandiricilar - Image Seter

B) Termal Transfer-Dye Sublimation-Solid Ink Y azicilar

C) Lazer Yazicilar

D) Miurekkep Puskirtmeli - Ink-Jet Y azicilar

Asagidakilerden hangis lazer yazicilarin 6zelliklerinden degildir?

A) Puskirtmeli yazicilara gore daha yavas baski yapar.

B) Ka&gidin yan sira astat ve aydinger Uzerine de cikis alabilir.

C) Bilgisayar ile haberlesmesini saglayan bir dili (Postscript, PCL ve Ouick Draw)
bulunmaktadir.

D) Gunimuzde en kaliteli baski yapabilen yazicilardir.

Asagidakilerden hangis film cikista kullamilir?

A) Lazer Pozlandiricilar - Image Seter

B) Termal Transfer-Dye Sublimation-Solid Ink Y azicilar
C) Lazer Yazicillar

D) Mdurekkep Puskirtmeli - Ink-Jet Yazicilar

Asagidakilerden hangisi ¢ikis almak igin verilen komuttur?
A) FilesImport

B) File>Print

C) FilesSave

D) FilesExport

Fit on paper segenegi neiseyarar?
A) Isi basilacak sayfa ebadina gore sigdirir.
B) Sigmayan kismu ikinci kagida basar.
C) Sayfay: dorde bolerek cikis verir.
D) Terscikis verir.
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DEGERLENDIRME OLCEGI

Ogrenme faaliyetinde kazandiginiz becerileri asagidaki tablo dogrultusunda 6l gliniiz.

Performans Degerlendirme

Evet

Hayr

1. File/print komutu ile gikis penceresini agabildiniz

mi?

2. Yaziciy1 segebildiniz mi?

3. Basilacak sayfdar segebildiniz mi?

4. Kopya sayisin segebildiniz mi?

5. Baski buytkl ik boyutunu segebildiniz mi?

6. Sayfabask: seklini segebildiniz mi?

7. Cikis aabildiniz mi?

8. Orijinae uygunlugu kontrol edebildiniz mi?

9. Duzeltmeleri yapabildiniz mi?
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MODUL DEGERLENDIRME

Faaliyet degerlendirmeniz sonucunda hayiri isaretleyerek yapamadiginiz islemleri
tekrar ediniz.

Tdm islemleri basaryla tamamladiysamz bir sonraki faaliyete geginiz.
DEGERLENDIRME

Bir fatura veya irsaliye Ornegini alarak gerekli gizimleri yapip ¢ikisimt ainiz, kontrol
ve duzeltmelerini yapiniz.

DegerlendirmeKriterleri Evet Hayir

» Verileri (CD,resm maket ve baski oOrnekleri)
eksiksiz olarak bilgisayar ortamina aktardimz m?

Verileri bir klasdrde toplayabildiniz mi?

Yeni bir belge acabildiniz mi?

Belgeyi dogru sekilde kaydedebildiniz mi?

Gorsel 6geleri programa sorunsuz aktarabildiniz mi?

Cizilecek gorseli arka plana atabildiniz mi?

Cizimleri sorunsuz yapabildiniz mi?

V| V|V |V |V ]|V |V

Renklendirmeleri dogru ve sorunsuz yapabildiniz
mi?

Y azilar1 sorunsuz yazabildiniz mi?

Elemanlar: gruplayabildiniz mi?

Cikis alabildiniz mi?

V|V |V |V

Orijinae uygunlugu kontrol edebildiniz mi?

» Duzeltmeleri yapabildiniz mi?

DEGERLENDIRME
Y ukaridaki sorulara cevaplarimz olumsuz ise ilgili bilgi konularim ve uygulamalar
tekrarlayimz. Cevaplarimz olumlu ise bir sonraki module gegebilirsiniz.
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CEVAP ANAHTARLARI

CEVAP ANAHTARI-1

1 C
2 D
3 B
4 C
5 B
6 B
7 A
8 A
9 D
10 D
11 D
CEVAP ANAHTARI- 2
1 D
2 A
3 A
4 B
5 A
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